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Select the application, you would like to get help about:

http://www.flooddroughtmonitor.com/Onlinedocumentation/08_Reporting_CTCN_LakeVic.pdf
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http://www.flooddroughtmonitor.com/Onlinedocumentation/09_Decision_CTCN_LakeVic.pdf
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1 Introduction and background 

The Data and Information application is developed to ensure that any user will always have a 

basic data set available for planning related to water resource, drought or flood management.  

The objective is to provide spatially distributed data in near real time for 
any focus area in the globe.  

The available data is originating from a number of different data sources, which are all available 

in near real time and disseminated through the Data and Information application. The data 

relates to different climate variables, climate forecast data, climate change data, and drought 

related indices and flood related data. 

The Data and Information application contains a number of different data types having in 

common the following: 

• Spatially distributed data (raster data visible on a map) 

• Temporal resolution maintained in near real time (data is updated regularly) 

• Short time delay (data is published with a maximum delay of 5 days) 

• Available for download through the Data and Information application in commonly used 
formats (netcdf file) 
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2 Quick guide for first time user 

This section contains a brief introduction to the Data and Information application for first time 

users. For a more detailed description see the following sections. The specific data types are 

described in details in section 4. 

2.1 Select data to view or analyse 

Once you have logged in, the available data types are listed by choosing Select under the Data 

tab. Open this menu to select which data should be made available (this selection can be 

changed later on). 

 

Figure 1 Select menu in the Data tab 

The selected data will be available for viewing, download and analysis. Note that it’s ONLY the 

data selected that is available for further processing.  

See section 3.2 for a detailed description. 

 

Figure 2 Selecting the data to work with in the Select dialog 
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2.2 View data 

The selected data can be viewed from the Layer menu, which allows you to view each time step 

of a selected data type. See section 3.3 for more details. 

 

Figure 3 View data from the Layer menu 

2.3 Download data as netcdf files 

The tools menu is used to download and process the selected data. Use the tool called Raster 

file to download any of the available data files as a netcdf file. To download a data file: 

• Select the layer you would like to download data from 

• Select the Raster File under the Tools section 

• Specify the period and press Download 

• Then on the following dialog showing the file size, and the file name, press Download. 
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Figure 4 Download data as netcdf files 

Note: the zip file contains the raster as .nc file, which can be open in most GIS tools. In addition, 

a legend file as .qml is associated to the .nc file. This legend file can be used in QGIS to load 

the default symbology. 

2.4 View or download time series 

The tools menu contains a number of different options for processing and analyzing the selected 

data types. Data could be extracted at different spatial resolutions from the entire focus area to 

point locations, and could be presented as time series, envelope plots or chart plots. See 

section 3.3.2 for details on the tools menu.  
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Figure 5 View or download time series 
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3 Functionality 

This section contains a brief description of the functionalities currently available from the Data 

and Information application.  

3.1 Info menu 

The information menu allows the user to access the User guide, Knowledge portal, and About. 

 

Figure 6 Information menu 

3.1.1 User guide 

Opens a pdf version of the user guide. 

3.1.2 Knowledge portal 

Here you can start discussions related to the portal. 

3.1.3 About 

Opens a short description of the system and contact information to the administrator. 

3.2 Select 

The Select menu is used to select the favourite data or the data available for viewing and 

analysis. The user selection is stored and will be used the next time the user logs in. The 

Settings dialog contains the following information: 

• Overview of all available data in the Data and Information application (for the particular 
focus area) 

• When clicking on a data type a brief description is displayed 

• When selecting one or several data types and pressing Update, the selected data will 

be available for viewing and analysis, see section 3.3. 
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Figure 7 Select menu 

 

Figure 8 Available data in the Data menu is updated based on the selection in the Select dialog, see 
section 3.3 for more information. 

3.3 Data menu 

3.3.1 Layer visibility 

The Data menu is used for viewing the data types selected in the Select dialog, see section 3.2. 

The following functionality and information is available: 

• List of available data types (based on the selection in the Select dialog, see section 
3.2) 

o Select or unselect a data type from the list 
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o When selecting a data type it appears on the map view showing the most recent 

time stamp 

• Legend for the selected data type could be toggled on and off by clicking the two 
arrows in the top of the legend 

• Timeline for the selected data type is shown at the bottom of the screen. Gaps in the 
time line denotes periods with missing data 

o Click within the time line to view the data at the specific time step 

• Current time step is shown at the lower right part of the screen 

o Use the step forward or backwards buttons to change the time step 

 

Figure 9 Overview of functionality in the Data menu 

3.3.2 Tool functionality 

The Tools menu opens below the data type selection, allowing the user to download data and 

perform a simple processing such as area-weighted time series. 
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When opening the Tools menu a dialog with options for a) tool selection and b) tool 

configuration appears.  

The available tools depend on the selected data layer.  

 

Figure 10 Available tools will be displayed depending on the selected data layer 

Tool raster file (download netcdf file) 
The “Raster file” tool is used to download the selected data type as a netcdf file. To download 
the data file: 

• Select the data type and select the “Raster file” tool 

• Specify the time period to download data for 

• Press the “Extract” button which will calculate the estimated file size and display this in a 

dialog 

• Press “Download” to download the file as a netcdf file  

 

Available tools 
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Figure 11 Specify the time period to download data for, click on Download and then a dialog with the 
estimated file size will appear. 

Note: the zip file contains the raster as .nc file, which can be open in most GIS tools. In addition, 

a legend file as .qml is associated to the .nc file. This legend file can be used in QGIS to load 

the default symbology. 

Tool area (time series and plotting tools) 
The tools operate on different spatial resolutions – available options depend on the selected 

tools. The options are: 

• All focus area. The tools produces an area weighted time series for the entire focus 
area. 

• User location. Time series extracted at user specified locations (see following section 

for more details). 

• Subarea layer. Time series processed as area weighted time series for a user specified 

subarea. 

• Point layer. Time series processed as area weighted time series for a user specified 
point location. 

Pressing the “Download” button downloads the data as a csv file. Pressing the “Chart” button 
displays a plot with the tool result. 

 

Figure 12 Tools are available at different spatial resolutions (options depend on the selected tool) 
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All focus area 

Selecting the “All focus area” produces an area-weighted result of the data type for the entire 

focus area, see Figure 13 for an example with a time series tool. The time series plot is shown 

with area weighted data and long-term average data. 

 

Figure 13 Area weighted plot for the entire focus area 

Subarea layer 

When selecting the “Subarea layer” a selection of the available subareas appears. Selecting a 
subarea will highlight the area on the map (or vice versa). Pressing “Chart” will produce a plot 
with the area weighted results, pressing “Download” will download the data.  

 

Figure 14 Subarea selection 
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Point layer 

When selecting the “Point layer” a selection of the available locations appears. Selecting a 

point will highlight the location on the map. Pressing “Chart” will produce a plot with the area-

weighted results, pressing “Download” will download the data.  

 

Figure 15 Point layer selection 

User location 

The “user location” allows the user to extract data from the data layer at user specified 

locations. The procedure is: 

• Click on the map to define the location. 

• The system will retrieve the data at the location. 

• Several locations can be retrieved. 

• Press the “Download” button to get the data 



 

 

   

   
  

 

 13 

 

Figure 16 User location selection 

Time series Tool 
The time series tool produces an area weighted time series for the selected area. The time 

series uses the same temporal resolution as in the data file. 

 

Figure 17 Output from Time series tool 

Time series (monthly) Tool 
The time series tool produces an area weighted time series for the selected area. The time 

series contains monthly accumulated values, and contains an item with the actual data (black) 

and an item with the long-term mean of each of the monthly time steps (red). 
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Figure 18 Output from Time series (Monthly) tool 

Envelope plot Tool 
This tool is only available for ensemble based data types, and produces a plot showing the 

median, 25 percentile and 75 percentile of the ensemble values. 

 

Figure 19 Output from Envelope tool 

Column plot Tool 
The column chart tool is only available for selected indices, and produces a plot showing the 

coverage, in percentage, of different drought or flood categories.  
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Figure 20 Output from "Column chart" tool 

3.3.3 Tool tips 

Tips are available for all layers and tools by clicking on the layer name or tool name, see Figure 

21. 

 

Figure 21 Tips displayed for a selected layer. 

3.4 Document menu 

The document menu opens a dialog listing the available documents associated with the 

particular focus area. The documents could be fact sheets with more information on specific 

data types, video showing the temporal and spatial change of a data type, custom made drought 

reports or other documents associated with the specific focus area. 
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Figure 22 Document menu showing a list of available documents 
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4 Data description 

This section contains a description of the available data sources in the Data and Information 

application. 

4.1 TRMM related data 

Title  Tropical Rainfall Measuring Mission (TRMM) 

Description The Tropical Rainfall Measuring Mission (TRMM) is the first Earth Science 

mission dedicated to studying tropical and subtropical rainfall.  

The TRMM is a joint mission between the National Aeronautics and Space 

Administration (NASA) and Japanese Aerospace Exploration Agency 

(JAXA) dedicated to monitor rainfall in the tropics through microwave and 

visible infrared sensors, including the first space-borne rain radar. By use 

of a low-altitude orbit (350km), TRMM is complement of state-of-the-art 

instruments provide high accurate measurements. 

It measures precipitation that falls within 50 degrees north and 50 degrees 

south of the equator. 

 INDICATOR USAGE 

Index 

interpretation 

TRMM is especially useful in cases where consistency in precipitation data 

is required over many years, such as is the case for hydrological design, 

flood risk assessment, water resources management.  

Spatial extent From 50 degrees north to 50 degrees south of the equator 

Spatial and 

temporal 

resolution 

Spatial resolution: 0.25 degree 

Temporal resolution: resampled to daily rainfall product from 2000 to 

present 

Source http://trmm.gsfc.nasa.gov  

Example of 

usage 

Rainfall event across the focus area during the 6th of November 2017. 

 

http://trmm.gsfc.nasa.gov/
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 INDICATOR CALCULATION 

Data 

requirements 

and calculation 

The original 3-hourly real-time rainfall data in mm/h from NASA is 

resampled to daily product in mm/day. Negative values have been 

removed during the processing. 

Update 

Frequency 

Daily  

Related indices SPI 1-month, SPI 3-month, etc 

Data source 3B42RT (daily) 

 

4.1.1 Rainfall deviation (30 days) 

Title  Rainfall deviation (30 days) 

Description Deviation of accumulated rainfall from the long term mean within the last 

30 days. Calculated based on the TRMM rainfall where the long-term 

mean is based on TRMM data since 2000. 

 INDICATOR USAGE 

Index 

interpretation 

Used to locate areas with rainfall surplus or deficit within the last 30 days. 

Spatial extent As TRMM data 

Spatial and 

temporal 

resolution 

Spatial resolution: 0.25 degree 

Temporal resolution: Updated daily as TRMM rainfall gets updated. 

Source Processed based on TRMM data 

Example of 

usage 

Illustrates the how the accumulated rainfall deviates from the mean 

accumulation within a given area. Used to locate areas with rainfall surplus 

or deficit across the last 30 days. 
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 INDICATOR CALCULATION 

Data 

requirements 

and calculation 

Based on daily TRMM rainfall and calculated as TRMM - TRMMmean for 

the last 30 days 

Update 

Frequency 

Daily 

Related indices  

Data source Based on TRMM data 

 

4.1.2 Standardised Precipitation index (SPI)  

Title  Standardised Precipitation index (SPI) 

Description The SPI is based on the probability of precipitation for any time scale. The 

probability of observed precipitation is then transformed into an index. It is 

used in research or operational mode in more than 70 countries. 

 INDICATOR USAGE 

Index 

interpretation 

SPI is typically categorized using the following classification: 

> 2 Extremely wet 

1.5 to 2 Very wet 

1 to 1.5 Moderately wet 

-1 to 1 Near normal 

-1.5 to -1 Moderately dry 

-2 to -1.5 Severely dry 

< -2 Extremely dry 

 

A drought event occurs any time the SPI is continuously negative and 

reaches an intensity of -1.0 or less. The event ends when the SPI 
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becomes positive. Each drought event, therefore, has a duration defined 

by its beginning and end, and an intensity for each month that the event 

continues. The positive sum of the SPI for all the months within a drought 

event can be termed the drought’s “magnitude”. 

Because the SPI is normalized, wetter and drier climates can be 

represented in the same way; thus, wet periods can also be monitored 

using the SPI. However, it must be stressed that the SPI is not suitable for 

climate change analysis because temperature is not an input parameter. 

Spatial and 

temporal  

extent 

From 50 degrees north to 50 degrees south of the equator. (Based on the 

TRMM data and the same values are applied) 

Available from 2000 to present. 

Spatial and 

temporal 

resolution 

Spatial resolution: 0.25 degree 

Temporal resolution: resampled to daily rainfall product from 2000 to 

present 

(Based on the TRMM data and the same values are applied.) 

Source http://www.wamis.org/agm/pubs/SPI/WMO_1090_EN.pdf 

Example of 

usage 

The following SPI products are available: 

• SPI 1 month: the one-month SPI provides a comparison of the 
precipitation over a specific one-month period with the 

precipitation totals from the same period for all the years included 

in the historical record. 1-month SPI reflects relatively short-term 

conditions, its application can be related closely with short-term 

soil moisture and crop stress, especially during the growing 

season. 

• SPI 3 month: the three-month SPI provides a comparison of the 

precipitation over a specific 3-month period with the precipitation 

totals from the same 3-month period for all the years included in 

the historical record. A 3-month SPI reflects short- and medium-

term moisture conditions and provides a seasonal estimation of 

precipitation. 

• SPI 6 month: the 6-month SPI compares the precipitation for that 
period with the same 6-month period over the historical record. 

The 6-month SPI indicates medium-term trends in precipitation. 

 INDICATOR CALCULATION 

Data 

requirements 

and calculation 

The original 3-hourly real-time rainfall data in mm/h from NASA is 

resampled to daily product in mm/day. Negative values have been 

removed during the processing. 

Update 

Frequency 

Daily  

Related indices SPI 1-month, SPI 3-month, etc 

Data source TRMM 3B42RT 
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4.2 Seasonal forecast 

Title  Seasonal forecast 

Description The Climate Forecast System (CFS) version 2 is run by the Environmental 

Modeling Center at NCEP and became operational in March 2011.  It is a 

fully coupled model representing the interaction between the Earth's 

atmosphere, oceans and land. The variables available include 

precipitation and surface temperature. The forecast data is made available 

in a form of an ensemble forecast with several months lead time. 

 INDICATOR USAGE 

Index 

interpretation 

Provides ensemble input of forecasted rainfall. 

Spatial extent Global coverage (Longitude Range: 180W to 180E, and Latitude Range: 

90S to 90N) 

Spatial and 

temporal 

resolution 

Spatial resolution: 1 degree 

Temporal resolution: daily 

Source http://cfs.ncep.noaa.gov/  

Example of 

usage 

Ensemble members used as climate input for hydrological, water resource 

or crop models for evaluation of a future situation. 

 

 INDICATOR CALCULATION 

Data 

requirements 

and calculation 

The computation consists of construction of the 20-member ensemble 

forecast. The original product is resampled from 6-hourly to daily. 

Update 

Frequency 

Daily 

Related indices SPI 1-month, SPI 3-month, etc. based on forecasted rainfall 

Data source NCEP CFS v2 

 

http://cfs.ncep.noaa.gov/
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4.3 Climatology 

Title  Climatology 

Description Climatology or historical ensembles is a way to generate ensembles 

based on the historical rainfall to be used as a “prediction” of how the 
future rainfall will evolve. Climatology is very useful if forecasted rainfall is 

not available or the skill of the forecasted rainfall is poor. 

 INDICATOR USAGE 

Index 

interpretation 

Provides ensemble input of forecasted rainfall based on the historical 

observations. 

Spatial extent From 50 degrees north to 50 degrees south of the equator 

Spatial and 

temporal 

resolution 

Spatial resolution: 0.25 degree 

Temporal resolution: daily 

Source TRMM data 

Example of 

usage 

Ensemble members used as climate input for hydrological, water resource 

or crop models for evaluation of a future situation. 

 INDICATOR CALCULATION 

Data 

requirements 

and calculation 

Climatology based on TRMM data from 2000 until today. Climatology is 

yearly time series of the historical TRMM rainfall.  

Update 

Frequency 

Daily 

Related indices SPI 1-month, SPI 3-month, etc. based on forecasted rainfall 

Data source TRMM data 

 

4.4 Temperature 

Title  Temperature 

Description The level-3 MODIS global Land Surface Temperature (LST) and Emissivity 8-

day data are composed from the daily 1-kilometer LST product (MOD11C2) 

and stored on a 1-kilometer Sinusoidal grid as the average values of clear-

sky LSTs during an 8-day period. 

 INDICATOR USAGE 

Index 

interpretatio

n 

Land surface temperature and especially the change in temperature over 

time is a valuable indicator for climate change and drought events.  
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Spatial 

extent 

Global coverage 

Spatial and 

temporal 

resolution 

Spatial resolution: 1 km but resampled to 5 km 

Temporal resolution: 8-day product from 2000 to present 

Source https://lpdaac.usgs.gov/dataset_discovery/modis/modis_products_table/mod

11c2   

Example of 

usage 

Temperature in itself is NOT an index, but could be used to detect changes in 

the temperature pattern from year to year. 

 INDICATOR CALCULATION 

Data 

requirement

s and 

calculation 

Download of MOD11C2 1 km 8-day product. Data resampled to 5 km 

resolution using a simple mean of the grid cells. 

Update 

Frequency 

8 days 

Related 

indices 

 

Data source MOD11C2 (8 day) 

 

4.5 Vegetation (NDVI) related data 

Title  Normalized difference vegetation index (NDVI) 

Description Normalized Difference Vegetation Index (NDVI), is used as an index of 

vegetation health and density. NDVI = (λNIR – λred) / (λNIR + λred)  

Where: λNIR and λred are the reflectance in the NIR and red bands, 

respectively.  

MODIS vegetation indices, produced on 16-day intervals and at multiple 

spatial resolutions. NDVI is closely correlated to vegetation canopy 

greenness, a composite property of leaf area, chlorophyll and canopy 

structure, and could be used as a base data set for monitoring of crop and 

vegetation status. 

 INDICATOR USAGE 

Index 

interpretation 

Varies between -1 and +1. Strong correlation with leaf area index and 

biomass 

NDVI in itself does not reflect drought or non-drought conditions, but could 

be used to detect vegetation cover. 

NDVI values Vegetation condition 

0.1 to 0.7 Vegetated land 

> 0.5 Dense vegetation 

https://lpdaac.usgs.gov/dataset_discovery/modis/modis_products_table/mod11c2
https://lpdaac.usgs.gov/dataset_discovery/modis/modis_products_table/mod11c2
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< 0.1 Near zero vegetation such as 

barren area, rock, sand or 

snow 

 

NDVI in itself is NOT a drought index, but could be used to detect 

changes in the vegetation pattern from year to year. 

 

Spatial and 

temporal 

extent 

Global coverage 

Available from 2000 to present 

Spatial and 

temporal 

resolution 

Spatial resolution: from 5600 m to 250 m 

Temporal resolution: Updated every 16 days based on two daily passes. 

The value is based on the maximum value during the 16-day period. 

Source http://modis-land.gsfc.nasa.gov/vi.html and 

http://e4ftl01.cr.usgs.gov/MOLT/  

Example of 

usage 

Evaluation of vegetation growth. Used as source data for a number of 

vegetation indices. 

 

 INDICATOR CALCULATION 

Data 

requirements 

and calculation 

Converted to netcdf format  

Update 

Frequency 

16 days 

Related indices Vegetation based indices 

Data source Terra-MOD13C1 (5600 m) 

 

  

http://modis-land.gsfc.nasa.gov/vi.html
http://e4ftl01.cr.usgs.gov/MOLT/
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4.5.1 NDVI deviation 

Title  NDVI deviation 

Description NDVI deviation is calculated as the deviation from the long-term mean. It 

expresses the current vegetation growth compared to the long term mean 

for the same period. 

 INDICATOR USAGE 

Index 

interpretation 

NDVI deviation could be used to define a drought as it is defined as the 

difference between the NDVI for the current time step and the long-term 

mean NDVI for the same month. 

DEVNDVI = NDVIi – NDVImean,m 

Where: NDVIi : NDVI for the current time step, and NDVImean,m : Long term 

mean NDVI for the same month 

• When DEVNDVI is negative, it indicates the below-normal 
vegetation condition/health and, therefore, suggests a prevailing 

drought situation. 

• The greater the negative departure the greater the magnitude of a 
drought. 

The limitation is that the deviation from the mean does not take into 

account the variability in the vegetation within the region. Hence a 

negative DEVNDVI could be caused by a different crop type. 

DEVNDVI 

values 

Condition 

<= 0.2 Severe drought 

(extremely dry) 

-0.05 to -0.2 Drought (moderately dry) 

-0.05 to 0.1 Near normal 

> 0.1 Above optimal (extremely 

wet) 

 

Spatial extent Global and available since 2000 

Spatial and 

temporal 

resolution 

Spatial resolution: 5600 m to 250 m 

Temporal resolution: 16 days 

Source Based on the NDVI data 

Example of 

usage 

Location of areas with a vegetation growth below the long-term average. 
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 INDICATOR CALCULATION 

Data 

requirements 

and calculation 

 DEVNDVI = NDVIi – NDVImean,m 

Where: NDVIi : NDVI for the current time step, and NDVImean,m : Long term 

mean NDVI for the same month 

Update 

Frequency 

16 days 

Related indices Vegetation based indices 

Data source Based on the NDVI data 

 

4.5.2 Vegetation condition index (VCI) 

Title  Vegetation condition index (VCI) 

Description Vegetation condition index (VCI) shows how close the NDVI of the current 

month is to the minimum NDVI calculated from the long-term record. 

 INDICATOR USAGE 

Index 

interpretation 

VCI values reflects the following: 

VCI values Condition 

50 to 100 % Optimal or above normal conditions 

Around 50% Fair vegetation condition 

0 to 35% Severe drought (local trigger values apply) 

0% Extremely dry and equal to the long term 

minimum 
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Spatial extent Global and available since 2000 

Spatial and 

temporal 

resolution 

Spatial resolution: 5600 m to 250 m 

Temporal resolution: 16 days 

Source Based on the NDVI data 

Example of 

usage 

 

 INDICATOR CALCULATION 

Data 

requirements 

and calculation 

 Vegetation condition index (VCI) shows how close the NDVI of the current 

month is to the minimum NDVI calculated from the long-term record. 

𝑉ܥ𝐼𝐽 =  ሺ𝑁ܦ𝑉𝐼𝐽 − 𝑁ܦ𝑉𝐼௠𝑖௡ሻሺ𝑁ܦ𝑉𝐼௠𝑎𝑥 −  𝑁ܦ𝑉𝐼௠𝑖௡ሻ ∗ ͳͲͲ 

 

Where: NDVImin and NDVImax are calculated for the same month from a 

long term record.  

Update 

Frequency 

16 days 

Related indices Vegetation based indices 

Data source Based on the NDVI data 
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4.6 Soil moisture related data 

Title  Soil Moisture Index (SWI) 

Description The soil water index (SWI) product contains daily synthesis of Soil Water 

Index derived from ASCAT SSM data at 25 km resolution (then resampled 

to 0.1 degree).  

The SWI algorithm, originally developed at Vienna University of 

Technology (TU Wien) and later improved by other research groups, uses 

an infiltration model describing the relation between surface soil moisture 

and profile soil moisture as a function of time. The algorithm is based on a 

two-layer water balance model. 

The data value used are using the largest characteristic time length giving 

the deepest penetration within the soil layers, and the values represent an 

average soil water index across 0.5 to 1 meter of the topsoil. 

 INDICATOR USAGE 

Index 

interpretation 

SWI is used as an indicator for the water availability in the upper part of 

the root zone.  

SWI in itself is NOT a drought index, but could be used to detect 

changes in the soil moisture pattern from year to year. 

Spatial extent Global 

Spatial and 

temporal 

resolution 

Spatial resolution: Spatial: 0.1 degree, Temporal: daily 

METOP-ASCAT satellite, from 2007 – present 

Source http://land.copernicus.vgt.vito.be/PDF/datapool/ and 

http://land.copernicus.eu/global/products/swi  

Example of 

usage 

 

 INDICATOR CALCULATION 

Data 

requirements 

and calculation 

- 

http://land.copernicus.vgt.vito.be/PDF/datapool/
http://land.copernicus.eu/global/products/swi
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Update 

Frequency 

Daily 

Related indices Soil moisture based indices 

Data source  

4.6.1 SWI deviation  

Title  SWI deviation 

Description SWI deviation is calculated as the deviation from the long-term mean. It 

expresses the current soil moisture compared to the long term mean for 

the same period. 

 INDICATOR USAGE 

Index 

interpretation 

SWI deviation could be used to define areas with unexpected low water 

availability in the root zone as it is defined as the difference between the 

SWI for the current time step and the long term mean SWI for the same 

period. 

DEVSWII = SWIi –SWImean,m 

Where: SWIi : SWI for the current time step, and SWImean,m : Long term 

mean SWI for the same month 

• When DEVSWI is negative, it indicates the below-normal water 
availability and, therefore, suggests a prevailing drought situation. 

• The greater the negative departure the greater the magnitude of a 

potential drought. 

Spatial extent Global 

Spatial and 

temporal 

resolution 

Spatial resolution: 0.1 degree 

Temporal resolution: Daily or 10 daily 

Source Based on SWI data 

Example of 

usage 

Example of how a SWI anomaly map from the Climate Prediction Centre 

(http://www.cpc.ncep.noaa.gov)  

http://www.cpc.ncep.noaa.gov/


 

 

   

   
  

 

30  

 

 INDICATOR CALCULATION 

Data 

requirements 

and calculation 

Based on SWI and requires SWI data from 2007 to present to make a 

reliable estimate of the long-term mean.   

Update 

Frequency 

Daily or 10 daily 

Related indices  

Data source Based on SWI data 

 

4.6.2 SWI percentile 

Title  SWI percentile 

Description SWI percentile expresses  

 INDICATOR USAGE 

Index 

interpretation 

A drought or water scarcity is often defined when the soil moisture 

percentile drops below 30 or 20 %. 

Spatial extent As SWI data 

Spatial and 

temporal 

resolution 

Spatial resolution: 0.1 degree 

Temporal resolution: daily or 10 daily 

Source Based on SWI data 

Example of 

usage 

Example of SWI percentile map 
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 INDICATOR CALCULATION 

Data 

requirements 

and calculation 

Calculated as the percentile value for the same period as the observed 

data (based on data from 2007 to present).  

Update 

Frequency 

Daily or 10 daily 

Related indices  

Data source Based on SWI data 

 

4.6.3 SWI percentile change 

Title  SWI percentile change 

Description Change in soil moisture percentile is used to evaluate the trend over a 

given period and locate areas where the soil moisture is increasing or 

decreasing. The SWI percentile is calculated for 1 week, 2 weeks and 1 

month change. 

 INDICATOR USAGE 

Index 

interpretation 

Positive values indicate an increase in soil moisture across the period 

while negative values indicate a decrease in soil moisture across the 

period. 

Spatial extent Global 
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Spatial and 

temporal 

resolution 

Spatial resolution: 0.1 degree 

Temporal resolution: Daily or 10 daily 

Source Based on SWI data 

Example of 

usage 

Example of SWI percentile change (1 month) showing areas where the 

soil is getting wetter or dryer over the last month. 

 

 INDICATOR CALCULATION 

Data 

requirements 

and calculation 

Calculated as the change in percentile value. 

Update 

Frequency 

Daily or 10 daily 

Related indices  

Data source Based on SWI data 

 

4.7 Climate change data 

Title  Delta change factors 

Description Coordinated Regional Climate Downscaling Experiment (CORDEX) is a 

World Climate Research Programme (WCRP) project with the goal to 

produce coordinated sets of regional downscaled climate projections 

worldwide, i.e. for each continent a model domain was defined to run a set 

http://cordex.org/
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of Regional Climate Models (RCMs). The initiative responsible for the 

generation of RCMs for Africa is called CORDEX Africa. The RCMs are 

driven by the new generation radiative concentration pathway (RCP) 

scenarios at a horizontal resolution of 0.44 degree. The RCM outputs are 

processed into so-called delta change factors for monthly mean rainfall in 

order to indicate projected changes in monthly mean rainfall. The factors 

represent for each month the ratio between the average in the control 

model run (1986-2005) and the projection model run (2081-2100). 

Changes are estimated for the medium radiation forcing scenario RCP4.5 

and the extreme radiation forcing scenario RCP8.5. 

 INDICATOR USAGE 

Index 

interpretation 

Precipitation and PET delta change factors are multiplied by the baseline 

conditions. Temperature delta change factors are added to the baseline 

conditions. 

Spatial extent Global 

Spatial and 

temporal 

resolution 

Spatial resolution: 0.44 degree  

Temporal resolution: resampled to monthly 

METOP-ASCAT satellite, from 2007 – present 

Source  https://esg-dn1.nsc.liu.se/search/esgf-liu/ (ESGF Data Node) 

Example of 

usage 

Monthly envelope chart of precipitation delta change factors showing 

expected increase or decrease in precipitation over a certain basin. 

 

 INDICATOR CALCULATION 

Data 

requirements 

and calculation 

- 

Update 

Frequency 

Static dataset 

Related indices - 

Data source CORDEX 

 

https://esg-dn1.nsc.liu.se/search/esgf-liu/
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1 Background 

1.1 Drought early warning system 

Drought early warning systems are an important component of the risk management part of the 

drought management process as highlighted in Figure 1. It provides an identification of a current 

or upcoming hazards and provides an assessment of the associated risk related to the hazards.  

The main objective of a drought early warning system is to detect when and if a drought hazard 

might occur and the location and severity of the hazard. Drought warnings could be expressed 

based on the hazard itself or on the associated risk towards specific vulnerable sectors or areas.  

 

 

Figure 1 Drought management (adapted from [2]) 

1.2 Risk assessment 

The identification of the timing and location of a drought event is the first step in a drought 

assessment or drought management process. The impact assessment aims at quantifying how 

the identified hazards affects specific areas or sectors exposed to this hazard. 

The vulnerability analysis provides a mean for analysing the causes behind the drought impact 

and the priority of these causes. This is an important step for increasing the effectiveness of 

drought risk management as it provides the means for drought interventions or mitigations 

measures to be targeted specifically against the underlying causes for the drought impact. 

The risk is expressed based on the vulnerability towards the impact from a specific hazard, or as 

the likelihood of harm, loss or disaster for a specific drought related hazard (see illustration in 

Figure 2). 
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Figure 2 Risk assessment workflow 

1.2.1 Hazard identification 

The identification of the timing and location of a drought event is the first step in a drought 

assessment or drought management process. It is typically based on different types of drought 

indices each representing the state of a specific drought related issue at different times. Drought 

indices could cover the entire spectrum of drought types: meteorological, agricultural and 

hydrological drought (see Figure 3). 

 

Figure 3 Different types of drought 

An example could be climate based drought indices describing the state of meteorological 

drought. The specific drought indices to be included should be based on locally accepted indices 

as well as scientific sound and validated indices.  

Examples of drought indices: 

• Rainfall deviation expressed through the standardized precipitation index (SPI), 

• Crop related drought hazard described through the vegetation condition index (VCI). 



 

 

   

   
  

 

 5 

The key requirement is that the indices should represent the current or future state, hence 

should be available in close to real time or as forecasted values. Spatially distributed indices are 

often a requirement as well, as the location of the drought hazard is critical. Exceptions would be 

indices related to specific locations as reservoirs, lakes, rivers etc. 

1.3 Exposure 

The exposure to drought relates to the identification of sectors or areas particularly sensitive to 

drought through impacts or consequences such as reduced crop yield, livestock losses, socio-

economic impacts or reservoir depletion. Examples of areas exposed to drought could be 

rainfed agricultural areas or urban areas relying on surface water resources. The exposure 

would often be illustrated in the form of GIS shape files or raster maps delineating areas of 

specific exposure. 

1.4 Hazard categories 

In order to express the severity of the drought hazard, drought categories are often used to 

classify the severity and impact of the hazard.  The classification for drought categories could be 

inspired from the US drought monitor system using drought categories from D0 (abnormally dry) 

to D5 (Exceptional drought) (for more information see Figure 4).  

 

Figure 4 Drought classification scheme (source: [3]) 

1.5 Impact assessment 

The impact assessment aims at quantifying how the identified hazards affects specific areas or 

sectors exposed to this hazard. The outcome will describe how specific drought related hazards 

impact e.g. the agricultural production or the water supply. Impact could be expressed in terms 

of direct losses, or changes but also in terms of hazard or drought categories within a specific 

exposed area. 

A typical way to illustrate the drought impact is through the use of drought categories where the 

areas within specific drought categories are calculated and presented in tables. The impact 

would be divided into exposed categories, e.g. rainfed areas, urban areas etc. The correlation 

between drought categories and specific impacts would often be assessed through a regression 

analysis looking at the correlation between past drought events and the impact. 
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1.6 Risk analysis 

The risk will be expressed based on the vulnerability towards the impact from a specific hazard, 

or as the likelihood of harm, loss or disaster for a specific drought related hazard.  

Risk is defined as the likelihood of harmful consequences, or expected losses (deaths, injuries, 

property, livelihoods, economic activity disrupted or environment damaged) resulting from 

interactions between natural or human-induced hazards and vulnerable conditions (UN-ISDR, 

2009, EC, 2011). The risk analysis will identify areas or groups at different risk levels, which will 

be the targets for the following adaptation or mitigation planning.  

Risk is often expressed as hazard x vulnerability.  
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2 Quick guide for first time user 

This section contains a brief introduction for first time users. For a more detailed description, see 

the following sections.  

2.1 Access to the Drought Assessment app 

The Drought assessment app is accessible from the landing page by clicking on the “Drought 
assessment” icon. 

2.2 Main content 

The Drought assessment app is a map based application, which has two main menus: 

• Warning 

• Risk 

2.2.1 Drought Warning 

The warning page allows the user to select a specific layer and apply a threshold value to 

highlight the areas that are affected by a specific hazard. 

 

Figure 5 Warning page of the drought assessment app 
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Warnings: The selection of layer is done 

by clicking on the Warning button. The 

selected layers will then appear in the tree 

view. It is always possible to edit them 

later.  

Edit: This is to edit the user-defined 

warning level. The Edit button is used to 

edit the threshold vale as well as the 

comparison type to be applied on the 

hazard. The map is instantaneously 

updated. 

View original: this allows the user to view 

on the map the original hazard layer 

without applying any warning level. 

 

2.2.2 Drought Risk 

The drought risk page provides an interface to assess risk based on hazards and vulnerability. 

The main output of this page is a map with overlaid hazard and vulnerability. 

 

Figure 6 Drought risk page of the Drought Assessment application 
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Hazards: 

• Layer: layers for the hazard can be 
selected from a list. 

• Legend: the user is able to edit the 
color code and values in the legend  

Vulnerabilities:  

• Layer: layers for the vulnerabilities 
can be selected from a list. 

• Legend: the user is able to edit the 
color code and values in the legend 

 

 



 

 

   

   
  

 

 i 

 
 
 
 

Basin Planning application 

User guide 
 
 
 
 

 

 

 
 
 
 

  



 

 

   

   
  

 

ii  

BASIN PLANNING APPLICATION 
 

1 Introduction and background .................................................................................... 1 

2 Quick guide for first time user ................................................................................... 3 

3 Functionality ............................................................................................................. 12 

3.1 Results ......................................................................................................................................... 12 

3.2 Analysis ........................................................................................................................................ 13 

3.3 Plan Setup ................................................................................................................................... 15 

4 Final remarks ............................................................................................................ 19 

 

 

 

 

 

 

 

 



 

 

   

   
  

 

 1 

1 Introduction and background 

The planning application is embedded in the web portal deployed within this technical 

assistance. It targets decision makers without any modelling expertise, and the overall concept 

is to utilize the refined water resources model, for evaluation of plans by stakeholders in the 

water and energy sectors. Use of the planning application rests on the concepts listed below: 

• Investments: these are investments decision makers want to implement within a specific 
plan; investments are limited to water supply, irrigation schemes, other types of water 

supply, hydropower, reservoirs and storage; investments are described as water user 

nodes in the water resources model, or as hydropower or reservoir nodes. 

• External factors: these are climate change and population growth; the external factors 

influence the model in different ways as they impact either the climate or the water 

demand simulated. 

• Plans: a plan is a collection of investments and external factors combined into a plan or 

scenario; each plan is represented by a set of inputs to the model.  

• Indicators: planning results are all indicators derived from the model result files, i.e. 
actual model results will not be shown but only indicator values. 

• Strategies: weighting system attributed to indicators expressing different policy and 
strategic focuses. 

 

Figure 1 Overall concept of and key components of the planning application. 

The technical workflow for the planning application is explained using a step-by-step description 

as follows: 

Step 1: Upload of the Lake Victoria water resources model was carried out. 
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Step 2: The baseline condition is established in the backend and made available for the user 

Step 3: User defines a number of investments to be included. 

• List appears with existing investments. 

• User is presented with dialog for adding new investments, added by clicking on the map 

followed by typing of parameters. When a new investment is added it appears on the 

map and in an overview list. 

Step 4: User defines a number of external factors to be included. 

• Climate change factor will be implemented through change factor multiplication on 

climate files. 

• Population growth is implemented by choosing the percentage of annual growth within 
the investment horizon year. 

Step 5: The user makes a new Plan with the new investments and external factors from steps 3 

and 4. 

• The baseline model is cloned and the alterations implemented in the backend. 

• The clone is a scenario model which represents the New Plan. 

• The scenario model is executed. 

• All the available indicators are calculated and the indicator results are stored. 

• The scenario model and the model results are deleted (not to be used any more) 

• User receives an email, as the plan is available. 

Step 6: User evaluates the plan, selects which indicators to use and defines strategies 

• When clicking on a plan the existing investments can be examined and are also shown 

on the map. 

• Indicator results are presented as tables, charts and on the map. 

• The user is able to change the indicator configuration and the results presentation will 
be updated. 

• The user creates strategies with weighting systems to evaluate the New Plan. 

Step 7: User selects reporting  

• Once evaluation of the plan is done, the user can prepare reports and export them. The 

reporting part will be done through the web portal, see chapter 3.3. 

 

  



 

 

   

   
  

 

 3 

2 Quick guide for first time user 

This section contains a brief introduction for first time users. For a more detailed description, see 

the following sections.  

 

1 Viewing the Baseline conditions 

1.1 
Select the plan 

When you enter the Basin Planning application 

tool, there are four main tabs, and the user lands 

at the “Results” tab. In it there are two options: 
 

Select model: here the user will find there is one 

model to be used according to your username 

(the dropdown list is there to make allowance for 

the existence of future models). 

 

Select plans to evaluate: there are five different 

plans to evaluate.  
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1.2 
Viewing investments 

Select the Baseline plan and click on “View 
investments”. Please take note of the different 
investment types available at the moment in the 

planning application: 

 

• Please go through the list and take note 

of any questions regarding the different 

investment types.  

• Choose HydropowerDam from the list 

and see the existing investments in the 

Baseline plan. 
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MultipurposeStorage investments and Lake 

Victoria 

Please select MultipurposeStorage investment 

type from the list. Observe the different 

investments available.  

• Choose Lake Victoria from the list and 

observe the investment information 

• Next, please have a look at the rest of 

the MultipurposeStorage investments.. 

 

 
WaterSupply and Irrigation 

Please select Irrigation investment type from the list. Why is it that the list is empty? Because the 

baseline conditions have no water supply nor irrigation investments. 

 

1.3 
Viewing results 

To view results from the baseline plan there are 

two options available: 

 

Select result indicator: here you have a selection 

of the available indicators for the baseline plan. 

 

Select aggregation level: for each indicator there 

are different levels of aggregation available. By 

default the following: 

 

Summary level: this level of aggregation 

represents the whole focus area 

Details level: this level allows viewing results at 

investment level 

Catchment level: this level of aggregation 

represents a summary at the catchment level 

 

• Please choose Hydropower production as 

an indicator, and Details as the level. 

View the table and click the Chart button. 
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• Please choose Monthly water level and 

observe the different results. Are these 

results possible according to your 

experience? 

• Is it possible to aggregate based on 

Summary (whole area) or Catchments? 

Why not? Because for this indicator it 

would not make sense to add up different 

water levels at different dam locations. 

 

2 Setting up a new Plan based on the Baseline plan 

2.1 To create a plan of your own that is departing from 
the baseline conditions established for your area, 
please go to the “Plan Setup” tab, and tick on the 
Baseline plan. 

Click the Clone button. 

• Select workgroup 

• Provide a Name and Description, where the 
user should state a summary of what the plan 
will include. 

• Click Next. 

 
 

 

 
 



 

 

   

   
  

 

 7 

2.2 When the user clones a plan, the user is making a 
copy of the original. Then the user is given the 
opportunity to add or remove investments, except 
for two types: HydropowerDam and 
MultipurposeStorage. This is because it is not 
allowed to remove hydropower plants or 
reservoirs from your baseline conditions.  

Therefore, it is very important that you capture 
correctly these two types of elements in your 
Baseline condition.  

 

 

2.3 
Editing an investment 

Select each of the HydropowerDam investments 

one by one, and specify a value of “Target power”  
• First click on the name of the investment 

then click the Edit button 

• Find the target power parameter and 

change the zero value to the amount of 

MW you find appropriate. 

• When finished editing the three power 

schemes press Next. 

• Please observe the interaction as you 

click, between the map view and the table 

with the investments list. 

 

2.4 
Selecting an external factor 

The final step of the plan setup is choosing 

whether you want to include the effect of climate 

change and/or population growth. 

 

• Look at the options of climate model, do 

these look familiar? 

• Where is the data coming from and what 

is the impact in the Baseline conditions if 

you add climate change to your clone? 

For the time being leave these options unchanged 

and click “Submit plan”. 
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3 Water Supply and Irrigation planning 

 
In this exercise, different possible future Investments can be included in a new plan (e.g.: hydropower 

schemes, irrigation scheme rehabilitation projects and potable water supply projects). We will focus 

on: 
1. “Water Supply”  
2. “Irrigation” 

There is also the “Other” investment type which is there to cover other types of demand the user would 

like to include in a plan, but that does not fall within irrigation schemes or potable water supply 

schemes. For each investment the following information will be required: Basic information and 

Parameter information. 

3.1 Clone the Baseline plan  

To start, go to Plan Setup and Clone the 

Baseline plan. Attribute a Name and a 

meaningful Description. 

 

Press Next. 

 

3.2 Create a new WaterSupply investment 

• Click New. 

• Choose WaterSupply from the list and 

then click on the “Choose on the map” 
button. 

• Click on the map, approximately on top 

of the location where the new water 

supply scheme will be in place to supply 

a certain town. Make sure you always 

click inside the catchment boundaries. 

Do you see the red star on the map? 

• Please click Add. 

 

 Add the Basic information and then go through 
the Parameters. 

• Enter the values as shown in the right-

hand side or enter your own information 

brought for testing. 

• Click OK. 
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This user is not expected to use any 
groundwater resources, but it would be possible 
to choose a fraction of groundwater if that was 
the case. 

 

 

3.3 Make a new Irrigation investment 

• Please click New. 

• Choose Irrigation from the list and then 

click on the “Choose on the map” button. 
• Click within the catchment of your choice 

for a location of your new irrigation 

scheme. 

• And click the Add button. 
 

 Add the Basic information and then go through the 
Parameters. As of now, there is no irrigation 
model attached to the planning application. 
Therefore, the information you choose in Area and 
Crop type is only informative. Therefore, the user 
is asked to add the water demand explicitly. 

• Enter the values as shown in the right-
hand side or enter your own information 
for testing. 

• Click OK. 

 

3.4 Press Next and Submit your new plan. 
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4 Analysis 

 
The different plans can be evaluated by comparing key Indicator results, as well as by running a 

simple MultiCriteria Analysis (MCA) and comparing the MCA results. The MCA score matrix needs 

to include concerns / priorities of different stakeholders in the basin. These stakeholder inputs are 

specified as importance criteria in a Strategy. In this exercise, you will evaluate the new investments 

by comparing the plans and running the analysis. 

 

The application calculates an MCA score for the whole area based on a MCA approach. Indicator 

results are grouped according to the type of indicator and the results are normalized across plans. 

 

The output from the normalization is afterwards combined with the strategy weights, which in turned 

are summed up to produce the final score, per plan and per strategy. 

 

4.1 Strategies 

The first step in the Analysis workflow is create 
strategies to be used in the analysis. 

• Please press “Edit Strategies”. 
• To create a strategy press Add. 

• Tick on the Indicators you would like to 

add to the strategy and attribute a 

weight. Please note the weights should 

add up to 100%. 

 

 Create a strategy with one indicator only 
focusing on energy production. This means that 
the plan with the highest energy production, 
according to this strategy, should score the 
highest in the analysis: 

• Name the strategy “Energy focus”. 
• Enter the description of what this 

strategy represents. 

• Give the total weight of 100. 

 

4.2 Next create a new strategy based on two 
indicators Hydropower production and Reservoir 
status. Attribute your own weighting scheme. 
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4.3 Attach one or more Strategies to the Plans 

To carry out an Analysis the user needs to 
attach strategies to the minimum of two Plans. 
Additionally, this attachment must be consistent. 
This means that a strategy based on an indicator 
of water supply, cannot be attached to a plan 
without any water supply investments. 

• Tick on the minimum number of two 
plans and press “Attach strategies”. 

• Tick on the strategies and click Save. 

You are now ready to complete the Analysis by 
clicking “View results”. 

 

4.4 The final score is a weighted sum of indicators, where the weights have been previously defined to 
reflect priorities or concerns in the basin. Focus can be given to development, or environmental 
sustainability. Which plan scores highest when compared across each one of your strategies? 
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3 Functionality 

This section contains a description of the functionalities.  

3.1 Results 

There are different types of investments available in the Planning application: 

• WaterSupply represents potable water production schemes; the water demand is 

calculated by specifying the population and consumption per capita.  

• Irrigation represents agricultural irrigation schemes; a water demand for the crop must be 

specified. 

• EnvironmentalFlow can be used to represent water demand needed for the environment, 

should you have environmental flow calculations for your catchment your catchment you 

insert this type of investment in your plan and set the water demand to match the result 

from your analysis. 

• Other type of water demand, represents water demand that does not fall within any of the 

categories above (for e.g. industrial, livestock, etc.) 

• HydropowerDam represents hydropower plants located at a dam; it requires an installed 

capacity and the power demand and it will return energy produced. 

• HydropowerRiver represents run-of-river hydropower schemes; this type of investment 

requires water demand and it will return water supplied. 

• MultipurposeStorage is the investment type that can be used to represent reservoirs and 

storage (lakes, etc.) within your catchment. 

The indicators constitute the different criteria based on which the plans will be evaluated. It is 

therefore important that stakeholders understand the meaning of the indicators and their 

variation across plans. Indicators should be well defined and should not be redundant. Indicators 

should also be mutually independent, meaning they do not convey information about each other 

such that one does not change the assessment of the other. 

There are currently five indicators available: 

• Annual energy production produced by hydropower schemes (GWh); this is directly 

dependent on the water level at the dam where the turbines are located. 

Hydroelectric power produced is calculated from the following formula: ܲ = 𝛥ℎሺܳሻ × ܳ × 𝜀ሺ𝛥ℎሻ × 𝑔 × 𝜌௪௔௧௘௥  

where P is the power generated, Δh is the effective head (difference) [L], Q is the 

discharge/release through turbine(s) [L3/T], ε is the machine (power) efficiency [-], g is the 

gravitational constant [L/T2] and ρwater is the density of water [M/L3]. The effective head 

difference is obtained by: 𝛥ℎሺܳሻ = ℎ௥௘௦௘௥௩௢𝑖௥ − ℎ௧௔𝑖௟௪௔௧௘௥ሺܳሻ −  ℎ௖௢௡௩௘𝑦௔௡௖௘ሺܳሻ ℎ௧௔𝑖௟௪௔௧௘௥ = max ሺℎ௧௔𝑖௟௪௔௧௘௥ሺܳሻ, ℎௗ௢௪௡௦௧௥௘௔௠_௥௘௦௘௥௩௢𝑖௥ሻ ℎ௧௔𝑖௟௪௔௧௘௥ሺܳሻ = ℎ௥௘௦௘௥௩௢𝑖௥_௕௢௧௧௢௠_௟௘௩௘௟ 
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𝛥ℎ௖௢௡௩௘𝑦௔௡௖௘ = Ͳ 𝜀ሺ𝛥ℎሻ = Ͳ.86 

• Annual reliability of supply either as the magnitude of the supply given a certain demand 

(m3/s), or as a fraction of demand supplied at a chosen level of probability of exceedance 

(%). 

The annual simulated water supply to users is calculated for each of the years of available 

data, where the hypothetical percentage of water supplied to meet a demand, at the 90% 

reliability of supply, is calculated to be equal to a certain percentage for e.g. 70%. 

Expressed differently, this means that for 9 out of every 10 years (i.e. 90% risk level) this 

water user would always receive 70 % or more of their required demand. 

• Groundwater sustainability index as a comparison of the total groundwater recharge of the 

basin to the total abstraction from groundwater on an annual basis (%). The following 

equation is used: 

Annual GW Sustainability (%) = 100 x (1 – (Abstractions / Recharge)) 

• Net Present Value is a measurement of profit calculated by subtracting the present value of 

costs (including initial cost) from the present values of benefits over a period (user specified 

currency). 

• Reservoir status is an indicator providing water level, reservoir downstream release and 

storage over time (m, m3/s and m3 respectively). 

• Reservoir status probability indicator uses the same reservoir downstream release and 

storage as the previous but provides results as duration curves. 

Results can be visualized at three different aggregation levels by default: 

• Details returns the indicator values of individual investments. 

• Catchments returns the indicator values summed up per catchment.  

• Summary returns the indicator values of investment types summed up for the whole focus 

area. 

The user can add aggregation levels by uploading the corresponding shapefiles when creating 

the baseline plan. 

3.2 Analysis 

Based on a Multi Criteria Analysis (MCA) approach, providing a structured framework for 

comparing a number of plans across strategies. The workflow involved in carrying the analysis is 

as follows: 

1. Define strategies 

2. Define weights 

3. Calculate relative scoring 

4. Combine the weights and scores for each of the options to derive and overall value for that 

strategy per plan 

5. Analyze the overall score for each plan 

6. Conduct a sensitivity analysis 
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Figure 2 Analysis stage of the planning application workflow. 

1. Define Strategies 

The MCA score matrix needs to include concerns / priorities of different stakeholders in the 

basin. These stakeholder inputs are specified as importance criteria in a Strategy.  

Strategies can have different focuses: for example domestic water supply can be given first 

priority, followed by livestock (other), hydropower and irrigation. 

The indicators constitute the different criteria based on which the plans will be evaluated.  

2. Define weights for each indicator 

Choose which indicators to use as criteria and attribute weights. 

Consensus should be reached; however, it is important to record disagreement to carry out a 

sensitivity analysis at a later stage. 

3. Calculate relative scoring 

The relative score needs to be calculated for the indicators results of each plan. Two 

calculations can take place to calculate a relative score: 

• Higher value preferable 100*(X-Xmin)/(Xmax-Xmin) 

• Lower value preferable  100*(Xmax-X)/(Xmax-Xmin) 

4. Combine weights and scores 

Weights and scores for each of the indicator results are multiplied.  

Total weighted score of each plan is obtained by adding up all indicator weighted relative 

scores. 

5. Analysis results 

The final result per plan and per strategy, allows a ranking and prioritization of each plan under 

the weighting scheme carried by each strategy.  
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The plan scoring the highest total relative weighted score can be ranked as the most preferred 

plan.  

The ranked list of plans combines indicator results on the same relative scale, thus reflecting 

overall plan preference. 

6. Sensitivity analysis 

The weighting of indicators can be altered.  

This can be done by cloning a strategy and editing it according to the new strategic goal, or by 

adjusting upon recognition of associated uncertainty and conflicting objectives of multiple 

stakeholders.  

 

 

 

 

3.3 Plan Setup 

Setting up new plans or editing existing ones, is done in the Plan Setup section of the Planning 

Application. 

Firstly the user decides which investments are maintained and/or which investments need to be 

newly created. It is possible to add new investments and each investment type requires different 

parameters; below is a guide per investment type, for all the basic information is needed: 

Basic information is where to attribute a meaningful Name to the plan as well as a 

Description stating a summary of key plan information including sources/references and aims. 

 Investment specific parameters 

 

Population is the number of people to be 

supplied by the scheme. 

Per capita water use is the estimated water 

use per day per capita. 

Distribution losses is the percentage of 

water that is lost while being conveyed from 

the production site to the users. 

Reservoir provides the option to set the 

source of water for the investment, it can 

either draw from an existing reservoir/storage 

or if “No Reservoir” is chosen it will withdraw 
from the river. 

Use groundwater? is a tick box used to 

activate/deactivate the parameter needed in 

case the investment uses groundwater as a 

source; if the model in the back end does not 

have this facility, this option will not be used. 

Percentage of demand satisfied by 

groundwater defines how much of the water 

demand is to be satisfied from the catchment 

groundwater source 

Define 

strategies 

by 

selecting 

indicators 

Define 

weights 

for each 

Indicator 

Calculate 

relative 

scoring 

Combine 

the 

weights 

and 

scores 

Analyze 

the 

overall 

score for 

each plan 

Sensitivity 

analysis 

to 

changes 

in weights 



 

 

   

   
  

 

16  

Net Present Value is a tick box used to 

activate/deactivate the parameters needed to 

apply the formula used to calculate this 

indicator: Initial cost of the investment 

specified by the user as the cost for the start 

year; Annual return is the expected annual 

benefit from the investment; and Discount 

rate is the annual discount rate which is kept 

constant. 

 

Water demand is the water needed for 

irrigation every month derived by the user. 

Use monthly water demand bounds is a 

multiplying factor to be used only in case 

results are needed for the RDM tool. 

Area is the area of the field in hectares. 

Crop is a dropdown list with different crop 

types to choose from. 

Distribution losses is the percentage of 

water that is lost while being conveyed from 

the source to the user. 

Return flow is the percentage of water that is 

estimated to be unconsumed and returned to 

the river system. 

Reservoir provides the option to set the 

source of water for the investment, it can 

either draw from an existing reservoir/storage 

or if “No Reservoir” is chosen it will withdraw 
from the river. 

Use groundwater? is a tick box used to 

activate/deactivate the parameter needed in 

case the investment uses groundwater as a 

source; if the model in the back end does not 

have this facility, this option will not be used. 

Percentage of demand satisfied by 

groundwater defines how much of the water 

demand is to be satisfied from the catchment 

groundwater source 

 

Water demand is the water needed for 

irrigation derived by the user. 

Distribution losses is the percentage of 

water that is lost while being conveyed from 

the source to the user. 

Return flow is the percentage of water that is 

estimated to be unconsumed and returned to 

the river system. 

Reservoir provides the option to set the 

source of water for the investment, it can 

either draw from an existing reservoir/storage 

or if “No Reservoir” is chosen it will withdraw 
from the river. 

Use groundwater? is a tick box used to 

activate/deactivate the parameter needed in 

case the investment uses groundwater as a 

source; if the model in the back end does not 

have this facility, this option will not be used. 
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Percentage of demand satisfied by 

groundwater defines how much of the water 

demand is to be satisfied from the catchment 

groundwater source 

 

Reservoir is a dropdown list to choose which 

dam the hydropower plant will be located at 

and drawing water from. 

Power demand is the estimated target power 

the turbines should aim to produce. 

Minimum head of operation is the required 

minimum water level at the dam below which 

no energy will be produced. 

Installed capacity is the total production 

capacity of the turbines. 

 

Water demand is the water needed for 

irrigation derived by the user. 

Return flow is the percentage of water that is 

estimated to be unconsumed and returned to 

the river system. 
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Initial water level is used to define the initial 

status of the water level in the reservoir. 

Bottom level is the bottom of the Reservoir 

Dam crest level is the highest water level in 

the Reservoir before spill occurs.  

Top of dead storage is the minimum level 

from which water can be utilized. If the water 

level is below this zone water can only be lost 

due to evaporation or bottom infiltration. 

Flood Control Level is the level above which 

water is released for flood control purposes. 

Level area volume table allows the user to 

fill in a table with defining the available area 

and volume for water as a function of the 

level. 
Include Losses and Gains is a tick box used 

to activate/deactivate the parameters required 

to simulate atmospheric losses and gains 

from the water storage such as Evaporation 

and Precipitation, as well as Infiltration 

losses through the reservoir bottom. 

 

Water demand is the water needed for 

irrigation derived by the user. 

Distribution losses is the percentage of 

water that is lost while being conveyed from 

the source to the user. 

Return flow is the percentage of water that is 

estimated to be unconsumed and returned to 

the river system. 

Reservoir provides the option to set the 

source of water for the investment, it can 

either draw from an existing reservoir/storage 

or if “No Reservoir” is chosen it will withdraw 
from the river. 

 

After defining the investments constituting the plan, the user can choose to add external factors. 
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Climate change 

This external factor influences the rainfall-

runoff model in the back end, by replacing 

the climate dataset from the baseline 

conditions, with a dataset corresponding to 

the climate change projection scenario 

chosen from the drop-down list. If the model 

in the back end does not have rainfall-runoff 

functionality then this external factor will be 

disabled. 

Population growth 

This external factor influences WaterSupply 

investment type, by altering the population 

parameter to a projection depending on a 

growth rate and total period. The calculation 

is done by the following formula: ܲ݌݋௙௨௧௨௥௘ = ݌݋ܲ × ሺͳ + 𝐺𝑟݋𝑤𝑡ℎ_𝑟𝑎𝑡𝑒ሻ𝑃௘௥𝑖௢ௗ 

 

4 Final remarks 

The focus of the Basin Planning application and its use in the Lake Victoria basin and Uganda is 

dependent on the underlying model which focuses on the impact at catchment and 

national level and will not provide a feasibility study of local impact of specific development 

options.  

It is designed to allow users to analyse the trade-off between different water uses in 

development plans, for example hydropower versus potable water supply investments, 

considering how much water abstraction is needed and the availability of water resources in the 

basin.  

Investments should be placed where there would be water available for that specific usage, 

so that the underlying model can take that consumptive use into account. 

Different plans must be evaluated against the same indicators and should be evaluated based 

on the same climate change scenario. 
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1 Introduction and background 

Dissemination in the form of reports or bulletins are critical in relation to planning as this enables 

the decision or policy makers to disseminate the actual plans or the background for the decision 

process to stakeholders. The content and format of the dissemination depends to a large extent 

on the specific content of the decision and the intended receiver of the report or bulletin. In some 

cases the reports or bulletins needs to be very detailed with technical content and in other cases 

it should highlight the key issues using non-technical terms. For this reason the reporting 

application is based on a process allowing the user to select between a number of default 

reports, or develop their own reports based on the specific requirements. 

The reporting application is based on reporting templates (Word documents) containing a 

number of tags, where the user is able to specify which type of content the reporting application 

should replace the tags with. Currently the tags could be replaced with images, text, charts or 

tables. 

 

 

Figure 1-1 Template report with tags and final report with input in the form of images, chart or text replacing 
the tags 

1.1 Template reports and tags 

Template reports are one of the key features in the reporting application. A template report is a 

Word document (docx file) containing the overall framework of the report. The reporting 

application is able to insert objects in the form of images, text, chart or tables at user specified 

locations in the template report, and converting the template report into a final report containing 

for example tables with the latest climate information, drought hazards or other information from 

the Flood and Drought Portal.  
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The location of the inserted objects (images, text, chart or tables) are specified by adding tags in 

the report, where a tag is specified by brackets (start and end bracket) with a text in between, 

e.g. “{this is a reporting tag}”. See Figure 1-2 for an example of a reporting template with 

reporting tags.  

 

 

Figure 1-2 Example of a template reports with reporting tags 

When loading the reporting template into the reporting application, all tags are listed and the 

user is able to specify what the reporting application should insert instead of each tag (images, 

text, chart or tables). See Figure 1-3 for an example. 
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Figure 1-3 Example of how tags are converted to reporting objects within the reporting application 

1.2 Automated reporting 

Another feature of the reporting application is the ability of generating reports automatically 

based on a user-defined schedule. Reports will be generated automatically – without any user 

action – based on the latest data available. A notification email will also be sent to all the 

recipients of the report. The email will contain a link to download the latest version of the report. 

 

Figure 1-4 Example of an email notification when a new report has been generated. 

2 Quick guide for first time user 

This section contains a brief introduction for first time users. For a more detailed description, see 

the following sections.  

This section explains how to use one of the default reporting templates built in to the system. 

For description on how to make a new report or upload user specific content, please refer to the 

following sections. 

2.1 Open the reporting application 

The reporting application is available from the landing page of the Flood and Drought Portal, see 

Figure 2-1. The reporting application will use the workgroup concept to determine which reports 

are available for viewing, editing and download.  
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Figure 2-1 Open the reporting application from the landing page 

2.2 Default reporting templates 

The reporting application contains a number of built in default reporting templates enabling the 

user generate reports with a default content without having to develop their own Word based 

template. The default templates could also be used as a starting point for a user defined report.  

The default reporting templates are accessed through the “Open” menu, where the all the 
default templates are marked with a “*” in from of the name, see Figure 2-2. Please note the 

following: 

• Default reporting templates are all developed by the system and are available as read-

only templates (user needs to clone the template to use them). 

• The report generate option is disabled 

In order to use a default reporting template within a specific basin please follow the following 

procedure: 

• Select a default reporting template (through the “Open” menu”) 

• Clone the reporting template 

o Specify a name for the cloned version 

o Specify the workgroup for the cloned version of the report 

o Update the description if needed 

• Press “Clone” to copy the default reporting template. 

After the reporting template is cloned the “Generate” option will be enabled and the user can 

generate the report for this specific basin. The report will be populated with updated content and 

can be viewed after the “Generate” option is executed. 
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Figure 2-2 Default reporting templates 

Main option to manage the reports are as follow: 

 

When working with a report, there are a few options available: 

 

2.3 View or edit content 

When opening a report with editing rights, refer to user workgroup, all the content of the 

reporting template will be editable. When pressing the edit button ( ) an Edit dialog is opened 

and the user is able to specify the content for the specific tag. Pressing the preview button ( ) 

enables the user to preview the content of the specific tag. 
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Figure 2-3 Edit reporting content 

2.4 Generate report 

The “Generate” menu generates the report by inserting all the user specified content into the 
reporting template and converting the report to pdf format. A dialog will appear at the end of the 

process allowing the user to download the generated report. 

 

2.5 Download report 

The “Download” menu enables the user to download an already generated report. Note that the 
report is not updated when using this option. 

2.6 Copy link to report 

The “Copy link” function provides a link to report. The link is automatically copied to the 
clipboard and can be used to access the generated report. The link can be used to share the 

report. Note: it is not needed to login to the Portal to access the report via this link. 
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3 Functionality 

This section contains a description of the functionalities. 

3.1 Open report 

The “Open” menu enables an overview of all accessible reports, based on the workgroup 
concept.  

3.2 New report 

The “New” menu enables the user to generate a new report. The following input are required: 

• Report title: Report title as it will appear in the system 

• Description: Short description of the report. 

• Template: Report template in Word format (docx format). The reporting template should 

contain tags in the form of brackets with a text e.g. ” {this is a reporting tag}” 

• Update frequency (optional): The frequency for automated update of the reports in 
weeks. The minimum time between two reports will be one day. No report will be 

generated automatically if left blank. 

• Alert email (optional): Email addresses to be notified when updated report has been 
generated based on the frequency. Several email addresses can be specified. No report 

will be generated automatically if left blank. 

 

Figure 3-1 New report 

When pressing the “Add” button a new reporting template will be generated and the list of the 
tags in the report template will be listed. The user should then specify the content of each of the 

tags before generating the report. 
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3.2.1 Default report templates 

All reports marked with a “*” in front of the name are default report templates. The reporting 
application contains a number of built in default reporting templates enabling the user to 

generate reports with a default content without having to develop their own Word based 

template. The default templates could also be used as a starting point for a user defined report.  

The default reporting templates are accessed through the “Open” menu, where the all the 
default templates are marked with a “*” in from of the name, see Figure 2-2. Please note the 

following: 

• Default reporting templates are all developed by the system and are available as read 
only templates (user needs to clone the template to use them). 

• The report generate option is disables 

In order to use a default reporting template within a specific basin please follow the following 

procedure: 

• Select a default reporting template (through the “Open” menu”) 

• Clone the reporting template 

o Specify a name for the cloned version 

o Specify the workgroup for the cloned version of the report 

o Update the description if needed 

• Press “Clone” to copy the default reporting template. 

After the reporting template is cloned the “Generate” option will be enables and the user can 

now generate the report for this specific basin. The report will be populated with updated content 

and can be viewed after the “Generate” option is executed. 

3.2.2 New report template 

It is possible to create a new template as a Report template in Word format (docx format). The 

reporting template should contain tags in the form of brackets with a text e.g. ”{this is a reporting 

tag}” 

For maps, it is recommended to add a frame around the text, this frame will then be adjusted 

around the map added as picture to the Word document. The best way is actually to create a 

one cell table, inside which the picture will be added, see below an example. Please note that a 

negative left indent will be give better result. 

 

Figure 3-2 Tags to be used as a map placeholder 
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Figure 3-3 Properties of the table 

3.3 Clone report 

The “Clone” menu creates a copy of a report and saves it in a new user specified name. Note 

that the user has the option of selecting the workgroup for the cloned report. 

3.4 Edit report 

The “Edit” menu enables the user to change or edit the report title, the description, change the 

reporting. 
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Figure 3-4 Edit dialog 

3.5 Delete report 

The “Delete” menu deletes the current report. Please note that the template and all the settings 
will be deleted from the system. The “Delete” menu is only enabled if the user is the author of 
the current report.  

3.6 Edit or preview reporting tags 

When opening a report with editing rights, refer to user workgroup, all the content of the 

reporting template will be editable. When pressing the edit button ( ) an Edit dialog is opened 

and the user is able to specify the content for the specific tag. Pressing the preview button ( ) 

enables the user to pre-view the content of the specific tag. 
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Figure 3-5 Edit reporting content 

3.7 Generate report 

The “Generate” menu creates the report based on template file and the user input for each of 

the reporting tags. The final report is converted to pdf format and will be available for download 

or through a link. The “Generate” option is used when a user needs to update the content of the 

report.  

3.8 Download report 

The “Download” menu enables the user to download already generated reports. Please note 
that this menu only downloads the existing report with the current content, the content of the 

report is not updated.   

3.9 Copy link 

The “Copy link” function copies a url or link to the latest generated report. The link could be used 
when submitting an email providing a link to the latest generated report. Pasting the link into any 

internet explorer would provide access to the report.  

3.10 Upload reporting content 

The user is able to upload content into the system, which could be a specific logo or a 

description within a txt file. The upload function is enables by selecting “Upload” tab. 

 

 

Figure 3-6 Upload tab 
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User uploaded items could be in the form of images (*.png files), chart (*.csv file), tables (*.csv 

files) or text (*.txt files). The procedure for uploading an item and making it available for a 

reporting tag is explained below, see also Figure 3-7. 

Procedure for uploading an item and making it available for a reporting tag: 

• Select the “Upload” tab 

• Press “New” and specify the information for the item to upload 

o Item: Name for the item as it will appear for the user 

o Description: Description as it will appear for the user 

o Type: Select the type of item to upload. Please note that the system will NOT 

validate the uploaded images or csv files and errors might occur if a file type is 

specified with a wrong extension type.  

o File: Browse and select the file to upload 

• The uploaded item will now appear in the list of uploaded items 

o Note that an uploaded item can be deleted, edited or cloned by the user 

• When editing a tag in a reporting template all user uploaded items are available by 

selecting the source type “Upload”.  

• Selecting an item within the source type “Upload” adds the uploaded item to the specific 
reporting tag. 

 

Figure 3-7 Process for uploading an item and making it available for a reporting tag 
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3.11 Automated reporting 

Based on the frequency, the update of reports can be automated. The reporting application will 

automatically generate a new report, when the last generated report is older than the user-

defined frequency. Several email recipients can be specified in the Alert email field to be 

informed when a new report has been produced. 

 

Figure 3-8 Edit dialog of the report where frequency and email can to be specified. 

A notification is sent by email when a new report has been generated. The email contains a link 

to download the report as PDF without having to login to the Flood and Drought portal. 

Indication about the next report is also added to the email to the recipients have an idea when 

will the next update.  

 

Figure 3-9 Example of email notification sent when a new report has been generated 
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Adaptation to climate change through improved 

information and planning tools for Lake Victoria  

Robust decision making tool 

The Robust Decision Making application complements the Guidelines and is used to 

analyse model outputs generated at the end of the Basin Planning application workflow. 

The Robust Decision Making tool helps with understanding how uncertain external factors 

may affect the performance of a plan. The tool is available through the web portal. 

Based on available information during the session, this guide decribes how to: 

- Loading model outputs to the tool. 

- Comparing the performance of two plans. 

- Assessing the vulnerability of each plan to failure. 

 

 Open the RDM tool 

 
 

Open the web portal:  

 

http://www.flooddroughtmonitor.com 

 

Please log in with your username and password. 

 

Click on the RDM tool icon to be re-directed to 

the tool. 
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1 Introduction to the Robust Decision Making tool 

 
The Robust Decision Making tool is embedded in the web portal deployed within this 

technical assistance. The tool supports decision making under uncertainty and can be used 

with outputs from any model. In this exercise, we will use outputs from the planning 

application on the web portal.  

Robust decision making focuses on evaluating investments under different combinations of 

external factors in order to identify combinations of external factors that are likely to result in 

failure. The purpose of the methodology is to help decision makers and stakeholders identify 

ways in which investments are vulnerable to factors outside of their control. Decision makers 

and stakeholders can then identify investments that are likely to perform well regardless of 

future conditions or, in other words, “robust” investments.  

As implemented in the tool, the methodology proceeds through the following steps: 

 

• Ensemble import: Import of ensemble simulation results including plan 

identifiers, external factor identifiers, and output indicators. 

• Identification of failure thresholds: Identification of failure thresholds for all 

output indicators. 

• Plan comparison: Comparison of plans according to different metrics, along 

with comparison of ensemble results to failure thresholds.  

• Vulnerability analysis: Identification of external factor values likely to cause 

plans to fail. 

 

2 Ensemble import 

 In this step, we import a .csv table containing ensemble simulation results. 

2.1 
Prepare .csv table for import 

Ensemble simulation results are imported into the tool as .csv tables. Ensemble results can be 

imported from any model or other analysis tool as long as the table formatting conforms to a few 

simple formatting rules. The basin planning tool in the web portal prepares a .csv table 

automatically using the correct formatting. However, if importing results from another tool, the 

following rules should be followed: 

 

• Each row of the table, apart from the head row, should present results from a single 

ensemble member. 

• The first column should be an index with unique value for each ensemble member.  

• The other columns should provide one of the following three types of information: 

o Plan identifier 

o Uncertain factor identifier 

o Output indicator 

• Each column should be given a label in the header row. 

• There are no constraints on the number of columns in the table. In other words, there 

are no constraints on the numbers of plan identifiers, uncertain factor identifiers, or 

output indicators. 
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2.2 
Select table for import 

A table can be selected for import 

either by browsing or by using drag-

and-drop functionality. 

 

 

 

 

2.3 
Import 

You can import the table by clicking 

on the “Import” button. 
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3 Define data types  

 
In this step, we categorize each column in the .csv table imported in the previous step. 

3.1 After import, each column heading (except the first column) is displayed on the “Define data 
types” tab. Each heading must then be categorized as one of three types using drop-down list 
functionality. 

• Plan identifier 

• Uncertain factor identifier 

• Output indicator 

Click the Next button after all column headings have been categorized. 

 
 

4 Select failure thresholds 

 In this step, we define a failure threshold for each of the output indicators. 

4.1 Define thresholds  

The column headings identified as output indicators in the previous step are displayed on the 

“Select thresholds” tab. A failure threshold must be defined for each threshold using text entry. 

Each threshold should be defined as either a maximum or a minimum value. 

 

The data range for each indicator is displayed in the “Data range” column. It’s not necessary 
that the failure threshold be within this range. In other words, it’s possible that all indicator 

values are acceptable, or not acceptable. 

 

Press Next after all failure thresholds have been defined. 
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5 View decision metrics 

 
In this step, the user is presented with two metrics that can be used to compare plans. 

 

5.1 Select output indicator 

In the first step, the user selects an 

output indicator for which metrics will 

be computed. The output indicator is 

selected from the drop-down list in the 

top left-hand corner of the tab. 

 
 

5.2 View plans 

Plans are displayed in the first column 
of the table. If two or more columns 
were defined as plan identifiers, then 
every possible combination of plan 
identifiers is displayed. 

 

5.3 View expected values 

Expected values are displayed in the 
second column of the table. The 
expected value is an average of 
indicator values for the plan given in 
the first column. 

 

5.4 View values of robustness metric 

Values of the robustness metric are 
displayed for each plan in the third 
column. The robustness metric is 
equal to the fraction of ensemble 
members with output indicator values 
that are not defined as failing. 

Click Next when ready to move on to 
the next step.  

 

6 Compare indicators 

 In this step. plotting tools are used to compare output indicator values to failure thresholds 
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6.1 Select plan 

Output indicators can be compared to 
failure thresholds for one plan at a 
time. A plan is selected using the 
drop-down list located in the top left-
hand corner of the tab. 

 

6.2 Select output indicators 

Two output indicators may be compared at a time. Select output indicators to be plotted on each 
axis using the output indicator drop-down lists. Output indicators are plotted together with 
threshold values for each indicator. 

Press next when ready to move on to the next step. 

 

7 Vulnerability analysis (table)  

 In the first vulnerability analysis step, 
we view external factor values that 
may cause plans to fail. 

 

7.1 Select plan 

The vulnerability analysis can be 
applied to one plan at a time. Select a 
plan using the drop-down functionality 
in the top left-hand corner of the tab. 

 

7.2 Select output indicator 

The vulnerability analysis can also 
only be applied to one output indicator 
at a time. Select an output indicator 
using the drop-down functionality at 
the top of the tab.  

7.3 View vulnerability analysis 

Results of the vulnerability analysis are displayed in a table. The table presents ensemble 
members with unacceptable values for the selected indicator. The ensemble index is displayed 
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in the first column along with values of uncertain input indicators in the next columns. Values of 
the selected output indicator are displayed in the final column and highlighted in blue. 

Click next when ready to move to the final part of the methodology.  

 

8 Vulnerability analysis (chart)  

 In the second vulnerability analysis 
step, we view results in chart form. 

 

8.1 Select plan 

The vulnerability analysis can be 
applied to one plan at a time. Select a 
plan using the drop-down functionality 
in the top left-hand corner of the tab. 

 

8.2 Select output indicator 

The vulnerability analysis can also 
only be applied to one output indicator 
at a time. Select an output indicator 
using the drop-down functionality at 
the top of the tab. 

 

8.3 Select uncertain input indicators 

The vulnerability analysis chart displays values for the selected plan and output indicator as a 
function of two uncertain input indicators. Select uncertain input indicators to plot on each axis 
of the chart using the drop-down functionality at the top of the table. can also only be applied to 
one output indicator at a time. Select an output indicator using the drop-down functionality at the 
top of the tab. 
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8.4 View vulnerability analysis 

The vulnerability analysis displays all ensemble members for a selected plan as a function of 
the two selected uncertain input indicators. Ensemble members with acceptable values for the 
selected indicator are displayed as open circles, while results with unacceptable values are 
displayed as blue circles. 

The chart can be used to identify combinations of uncertain input factor values that are likely to 
cause failure. 

 

 

 


